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Este dispositivo está de acordo com a Parte 15 das regras da FCC. A operação está sujeita às 
seguintes duas condições:

• Este dispositivo não pode causar  interferência prejudicial.
• Este dispositivo não deve aceitar qualquer interferência que possa  causar operação indesejada.

ANÚNCIO DE DIREITOS DE CÓPIA
Satloc Precision GPS Applications 
Copyright Satloc LLC, 2005. Todos os direitos reservados.

Nenhuma parte deste manual pode ser reproduzida, transmitida, transcrita, armazenada em um 
sistema de recuperação ou traduzida para qualquer idioma ou linguagem de computador, em 
qualquer formulário ou qualquer outro meio, eletrônico, mecânico, magnético, ótico, químico ou 
manual , sem prévia permissão escrita de Satloc, LLC.

GARANTIA  SATLOC LIMITADA
Os produtos da Satloc são garantidos, sujeitos às condições estabelecidas no Anúncio de Garantia 
Limitada de Satloc , PN 875-0066, que é incluído com todo sistema Satloc adquirido. Por favor leia, 
entenda, e siga as instruções para validar a garantia.

MARCAS REGISTRADAS
Satloc e o logotipo de Satloc, CSI Wireless e o logotipo de CSI Wireless, são marcas registradas de  
Satloc LLC de CSI Wireless Inc. e CSI Wireless LLC.

NOTÍCIA  PARA OS CLIENTES
Anúncio de revisão: A Satloc está continuamente melhorando seus produtos. Esta publicação 
poderá conter inexatidões técnicas ou erros tipográficos. Mudanças são periodicamente feitas no 
manual e estas mudanças serão incorporadas em novas edições desta publicação. Como tal, este 
manual está sujeito a mudanças sem anúncio prévio.

Contacte seu revendedor Satloc local para ajuda técnica. Para achar o revendedor autorizado 
próximo de você, telefone ou escreva para Satloc:

Satloc, LLC 
7650 E. Redfield Road, Suite B 
Scottsdale, AZ 85260

Telephone number: 
Fax number: 
E-mail address:

(480) 348-9919 
(480) 348-6370 
sales@satloc.com



Tradução para o Portugués feita em colaboração com Agrotec Tecnologia Agrícola e Industrial, 
Brasil (www.agrotec.etc.br).
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Visão geral do produto

O programa MapStar potencializa o uso dos sistemas de 
orientação Satloc, devido às suas avançadas funções de 
mapeamento e conversão de arquivos. O MapStar é um programa 
para mapeamento em pré-aplicação e reprodução e análise pós-
aplicação. 

O MapStar permite-lhe mostrar uma grande variedade de arquivos 
baseados em formatos GIS como plano de fundo dos mapas 
gerados pelos sistemas de orientação Satloc. Ele também lê e 
mostra os arquivos (*.log) da Satloc de forma que possam ser 
analisados e convertidos em arquivos em formatos GIS. 
Adicionalmente, as novas funções do MapStar permitem converter 
arquivos "shape" (*.shp) em mapas de prescrição para uso com os 
controladores de vazão da Satloc e ainda introduzir pontos de 
referência e planejar rotas diretamente no MapStar. 

MapStar:

• graficamente mostra, imprime e analisa informações gravadas 
com sistemas de orientação Satloc - você poderá visualizar 
detalhes da gravação tais como: 

• data e hora exatas da gravação

• velocidade em relação ao solo, rumo e altitude 

• qualidade do sinal GPS

• medição precisa das faixas, de eventuais falhas ou mesmo 
de áreas inteiras 

• taxa de aplicação exata em cada posição, incluindo 
suporte para controle em taxa variável. Você pode 
também definir diferentes cores e opções de 
© 2005, Satloc LLC
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apresentação para diferentes taxas de aplicação, 
resultando em mapas fáceis de interpretar

• mostra informações detalhadas de arquivos nos formatos 
LOG, SWA, VRC, e SMS  

• Importa arquivos GIS visíveis como plano de fundo, incluindo 
os formatos Satloc  BMF, JOB, e PMH; ESRI SHP; MapInfo 
MID/MIF;  CAD e DXF 

• exporta arquivos  GIS , incluindo informações de aplicação, 
percurso e direção para arquivos JOB, DXF, MID/MIF, SHP, e 
ASCII 

• permite editar ou criar novos arquivos GIS para salvá-los 
como arquivos Satloc no formato *.JOB para uso em 
aplicações Satloc

• permite introduzir pontos de referência e rotas diretamente 
no programa para uso posterior em aplicações Satloc
Número de Parte: 875-8086-002
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• gera mapas de prescrição a partir de arquivos SHP, para 
controle de fluxo a taxas variáveis

Figura 1-1. Exemplo de tela do MapStar.
© 2005, Satloc LLC
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Tipos de arquivos suportados

O MapStar Satloc para Windows é usado para mostrar em forma 
gráfica, imprimir e exportar informações gravadas por 
equipamentos Satloc.  Você também pode abrir arquivos GIS 
como plano de fundo, editá-los e salvá-los como arquivos *.JOB 
para uso em sistemas Satloc. O MapStar também permite que os 
arquivos sejam exportados em outros formatos.  

Aqueles arquivos podem ser agrupados todos com a extensão 
*.SMS para facilitar o carregamento de arquivos múltiplos para 
apresentação.

Tabela 1-1: Arquivos visualizáveis.

Tipo de 
Arquivo

Descrição

LOG Gerado pelos sistemas  AirStar, ForestStar, SwathStar, 

Satloc Lite, e Outback 360 

SWA Gerado pelos programas  FreeTrac para Windows 

VRC Gerado por programas Windows de Controle de Taxa 

Variável (VRC)
Número de Parte: 875-8086-002
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Tabela 1-2: Arquivos de plano de fundo.

Tipo de 
Arquivo

Descrição

BMF Mapa de informações vetorizadas  Satloc

JOB Arquivos de definição de  serviço AirTrac/AirStar 

DXF Conjunto GIS  formado por coordenadas WGS-84 

MIF Conjunto GIS  formado por coordenadas WGS-84 

PMH Gerado pelo programa Satloc MapStar 

SHP Informações  GIS (ESRI Shape)
© 2005, Satloc LLC
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Requisitos do sistema

O MapStar para Windows é projetado para funcionar em um 
computador compatível com IBM PC com Windows 95, 98, 2000, 
NT, ou XP. O computador necessita possuir no mínimo os 
seguintes recursos.

Requisitos

• CPU Pentium 100 MHz +

• Mouse compatível com Windows ou outro componente de 
apontamento e seleção

• Porta paralela (para a chave de código)

• 54 MB+ de espaço disponível no disco rígido

• Memória RAM 64 MB 

• Placa de vídeo VGA, SVGA, ou superior, com cores a 24-bit e 
resolução  800 x 600 ou maior 

• Leitor de cartões PCMCIA para ler os cartões gravados pelos 
equipamentos Satloc 

• Impressora jato-de-tinta ou de outro tipo com capacidade 
gráfica
© 2005, Satloc LLC



Instalação |  Página  9
Instalando o MapStar

Você pode adquirir o MapStar em CD ou baixando a versão 
demonstração do portal da Satloc na Internet (http://
www.satloc.com).

Ao usar o MapStar, você necessitará da chave decodificadora ou de 
senha para usá-lo plenamente. Sem o código, o MapStar irá operar 
em modo "Demo" (permitindo operá-lo plenamente apenas 
usando os arquivos de demonstração incluídos).   Veja “Ativando o 
MapStar” na página 11.

Para instalar o programa:

1. Descompacte o arquivo eventualmente baixado do site da Sat-
loc na Internet.  Se você adquiriu o MapStar em CD, prossiga 
com o Passo 3. 

2. Execute o programa  SETUP.EXE  (localizado no diretório  
"Disk 1" ). Isto irá iniciar o procedimento de instalação.

Nota: Se você tiver baixado os discos individualmente ao 
invés do arquivo único, maior, grave cada arquivo em um 
diretório próprio - entretanto você necessita apenas 
descompactar o Disco 1. 

Nota: Se você tiver adquirido o MapStar em CD, o 
procedimento de instalação do MapStar começará 
automaticamente após inserir o CD. 
Número de Parte: 875-8086-002
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3. Aceite as sugestões originais para copiar os arquivos do 
programa para o diretório C:\SATLOC\MSW . Os arquivos 
de serviço (demonstração) a serem abertos no modo  
"Demo" serão copiados para 
C:\SATLOC\LOGS\MSW_DEMO.

4. Os ícones do MapStar serão automaticamente colocados na 
tela do computador, para fácil início do programa. Você 
também pode iniciar o programa MapStar no Windows 
pressionando o botão Iniciar e escolhendo Programas > 
Satloc > MapStar for Windows.
© 2005, Satloc LLC
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Ativando o MapStar 

Para habilitar o pleno funcionamento de seu programa MapStar, 
você necessita uma licença de uso do programa (aqui referido 
como senha ou "chave decodificadora"). Você poderá adquirir, do 
revendedor Satloc de quem você comprou o produto, uma senha 
ou uma chave decodificadora.  

Uma senha ou chave decodificadora ativa o MapStar em um 
computador.  

Ativando o MapStar

1. Abra o MapStar no modo "DEMO"

2. No menu Help selecione Key Code Entry: Você verá a 
seguinte mensagem:

3. Digite sua senha e pressione o botão Submit Code. (NT ao 
invés deste procedimento, o programa neste ponto pode ser 
Número de Parte: 875-8086-002
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habilitado introduzindo a "Chave Decodificadora" no conector 
da porta paralela do computador.)

4. O MapStar estará então plenamente habilitado.
© 2005, Satloc LLC
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Tela do MapStar

A tela do MapStar consiste de uma área de visualização, Barra de 
Menus, Barra de ferramentas, Barra de Gerenciamento de 
dados  e Barra de Informações.

Figura 3-1. Tela do MapStar.

Adicionalmente à tela principal, a instalação do MapStar coloca 
dois ícones de atalho na tela de seu computador -  MapStar for 
Windows e Log Copy, os quais serão discutidos mais adiante 
nesta seção.

Barra de Gerenciamento de
Dados barra de ferramentas

Barra de Inform

Barra de Menus
Barra Principal
© 2005, Satloc LLC
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Barra de Menus

A Barra de Menus no topo da tela permite acessar todas as 
funções do MapStar através dos cinco menus principais: 

• File - cria um novo arquivo, abre um arquivo existente, 
carrega um arquivo gravado, ajusta as opções de gravação, ou 
imprime um relatório

• View - mostra/oculta as barras Principal, Gerenciamento de 
dados e Informações e ajusta opções de cores e de 
apresentação do mapa 

• Data Management - importa/exporta arquivos, introduz 
waypoints e gera ralatórios de controle de fluxo

• Vrate - importa arquivos SHP e visualiza-os como mapas de 
prescrição

• Help - apresenta respostas a dúvidas sobre o uso do 
programa

Barra Principal

A Barra Principal consiste de um conjunto de botões de acesso 
para as funções mais comumente usadas:

Figura 3-2. Barra Principal.
Número de Parte: 875-8086-002
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Tabela 3-1: Botões da Barra Principal.

Botão Ação

Limpa a tela preparando-a para a criação de um novo 
arquivo.

Abre um arquivo existente.  

Nota: Você pode abrir múltiplos arquivos pressionando 
e mantendo pressionada a tecla CTRL no teclado 
enquanto aponta e marca com o botão esquerdo do 
mouse os arquivos desejados, na tela que será aberta. 

Você pode classificar a lista de arquivos na janela em que 
eles aparecem, em ordem ascendente ou descendente, 
"clicando" nos campos  apropriados. 

Acrescenta  um arquivo adicional ao arquivo mostrado 
na janela ativa.

Grava todos  arquivos da janela ativa (LOG, SWA, VRC) 
em um único arquivo SMS (Conjunto de Mapas). 

Nota: O arquivo SMS contém uma lista dos arquivos de 
gravação e de mapas e suas respectivas localizações - ele 
não contém os dados daqueles arquivos. Assim, quando 
você abre um arquivo SMS novamente, ele poderá ape-
nas mostrar a lista dos arquivos e suas respectivas local-
izações.
© 2005, Satloc LLC
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Imprime o mapa que está na tela. A tela  Print Setup 
aparecerá, possibilitando digitar o nome da empresa, 
título e nome do serviço - Company Name/Title 
and Plot Title  - a serem impressos no cabeçalho.  
Esta janela de impressão também permite-lhe selecionar 
entre  Auto scale (automaticamente ajusta a área 
atualmente mostrada na tela ao tamanho do papel em 
uso na impressão) ou Fixed scale (você define uma 
determinada escala de impressão).

Nota:  Se uma página contém mais de um "canal", uma 
página será impressa para apresentação de cada canal.

Pré-visualiza o formato de impressão.

Seleciona objetos na tela. Também "clique" nisso para 
desfazer a seleção dos botões de  zoom/pan.

Ajusta tamanho e centraliza de forma a apresentar 
todos os mapas dos arquivos na tela.  

Aumenta / diminiu escala ("Zoom"). Posicione o cursor 
sobre a área do mapa que você deseja ampliar / reduzir.  
Pressione o botão esquerdo do mouse para aumentar; 
pressione o botão direito para diminuir.

Desloca o mapa em qualquer direção. Para deslocar o 
mapa, clique sobre um ponto do mapa, mantenha o 
botão pressionado e arraste na direção desejada.

Tabela 3-1: Botões da Barra Principal.

Botão Ação
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Mede distância entre um ponto e outro. Defina o ponto 
de início pressionando o botão esquerdo com o cursor 
sobre ele.  Libere a pressão sobre o botão esquerdo e 
desloque o cursor até o ponto de destino, pressionando 
o botão esquerdo sobre ele. A distância será mostrada 
na Barra de Informações na parte inferior da tela. 

Mede a área de um polígono. Defina o polígono "cli-
cando" com o botão esquerdo sobre os vértices do 
polígono desejado - após o terceiro vértice, a área 
medida passa a ser mostrada na Barra de Informações. 
Para abandonar o polígono e começar de novo, pres-
sione o botão direito do mouse.

Mostra o traçado para diferentes canais em uma apli-
cação VRC  (NT: aplicação com taxa variável). 

Tabela 3-1: Botões da Barra Principal.

Botão Ação
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Mostra uma  lista dos arquivos atualmente carregados, 
em uma janela própria.  A partir desta janela própria, 
você pode remover arquivos ativos, mostrar e imprimir 
relatórios dos detalhes dos arquivos, e exportar arqui-
vos.   

Importa arquivos GIS - JOB, PMH, DXF, MIF, e SHP. Veja 
"Capítulo 5: Trabalhando com arquivos GIS" para mais 
informações. 

Configura opções do Mapstar - modo "zoom", apresen-
tação das áreas aplicadas, apresentação das posições de 
gravação, latitude/longitude, escala, mapas de fundo, 
unidades e ajustes de impressão.  Veja “Ajuste das 
opções de exibição” na página 23. 

Mostra a versão do programa MapStar e código interno 
(um código criado quando da elaboração do programa). 
O botão “Sys Info” que aparece dentro da nova janela 
abrirá uma segunda janela mostrando os números das 
versões dos programas necessários para executar o 
MapStar e que estão atualmente instalados no sistema. 

Tabela 3-1: Botões da Barra Principal.

Botão Ação
Número de Parte: 875-8086-002
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Barra de Gerenciamento de Dados

A  Barra de Gerenciamento de Dados consiste de botões de 
atalho para tarefas freqüentemente executadas, tais como 
importar/exportar arquivos, elaborar um relatório de taxas de 
aplicação e introdução de waypoints. 

Figura 3-3. Barra de Gerenciamento de Dados.
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Barra de Informações

A Barra de Informações  permite visualizar importantes 
informações tais como latitude / longitude de um determinado 
ponto, volume de aplicação, área e volume total aplicado. 

Tabela 3-2: Botões da Barra de Gerenciamento de Dados.

Botão Ação

Importa arquivos de serviço do cartão PCMCIA para o 
disco rígido ou para outro disco / diretório. 

Nota: Recomendamos criar um diretório separado 
para cada serviço ou conta (NT um para cada cliente, 
ou para cada piloto, etc.).

Exporta arquivos de serviço  para diferentes formatos 
de arquivo - ASCII, DXF, MapInfo MID/MIF , ESRI Shape 
(SHP) a partir de arquivos formato LOG, SWA, ou 
VRC.

Gera um relatório impresso de Fluxo a partir de um 
arquivo de serviço (*.log).

Inclui waypoints (pontos de referência).

 

Latitude/Longitude Taxa de
Aplicação

Area Volume 
aplicado

Modo
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Figura 3-4.  Barra de Informações.

Adicionalmente, quando usando os recursos Measure Distance 

( ) ou Measure Polygon ( ) a distância ou área 
aparecerá no campo latitude/longitude da Barra de Informações.

Ícones na tela do Computador

O programa de instalação do MapStar colocará dois ícones de 
atalho na tela ("desktop"), para fácil acesso. 

MapStar Quick Start - "Clique" duas vezes sobre este ícone 
para abrir o programa MapStar.

Log Copy - "Clique" duas vezes sobre este ícone para copiar 
arquivos do leitor de cartões para o disco rígido do computador. 

 

Distância

Area

Atenção! Se você selecionar a opção Wipe Card na janela do 
"Log Copy" você apagará todos arquivos de serviço. Você verá 
primeiro uma janela de alerta, perguntando se você confirma 
que deseja apagar todos os arquivos.  
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Ajuste das opções de exibição

O ícone de atalho na Barra Principal permite ajustar as opções 
de exibição na tela do MapStar.  Após pressionar este botão, você 
verá a seguinte janela:

Figura 3-5. Janela de Opções de Exibição.
Número de Parte: 875-8086-002
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A janela Opções de Exibição permite configurar:

• opções de "zoom" - configura o que  o botão Zoom All 

( ) mostrará no modo  View Zoom Mode. Centraliza e 
mostra todos os dados gravados ou apenas posições aplicadas, 
e define se devem ser incluídos ou não mapas GIS

• opções de exibição para diferentes taxas de aplicação, em 
aplicações a taxas variáveis 

• como as áreas aplicadas são mostradas - em cores, 
preenchidas em blocos com ou sem bordas, mostrar onde 
estava sendo aplicado quando não deveria sê-lo ( bom para 
identificar um vazamento de válvula) 

• exibição de posições não aplicadas (NT translados, balões) 

• exibição de marcas gravadas, tais como pontos A, B e C, 
waypoints, marcas de interrupção, etc. 

• exibição de posições de gravação na forma de um pequeno 
triângulo

• opções de apresentação do arquivo gravado - tais como 
retardo na gravação para compensação e percentagem de 
sobreposição entre faixas contíguas

• apresentação de latitude / longitude 

• apresentação da escala do mapa na Barra de Informações 

• tamanho das letras nos textos de identificação das marcas

• mapas de fundo a serem mostrados na tela 

• opções de impressão

Esta seção aborda cada parte da janela  Display Options com 
mais detalhes.
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Opções de ajuste de zoom (View Zoom Mode)

View Zoom Mode controla os ajustes do botão de atalho 

Zoom All ( ) . View Zoom Mode tem as seguintes 
opções:

• All Logged Positions - selecione esta opção para mostrar 
centralizados todos os dados gravados na janela do mapa.  

• Sprayed Positions - selecione esta opção para mostrar 
centralizadas todas as posições aplicadas (e não todas as 
posições gravadas). 

• Include Job/GIS Positions - marque esta opção para 
centralizar e mostrar todas  informações carregadas na tela (ao 
invés de mostrar apenas os dados do serviço), incluindo todos 
mapas GIS.

Opções de ajuste de exibição da área (Display of Sprayed areas)

Display of Sprayed Areas tem as seguintes opções:

• Actual Spray Rate mostra o volume de aplicação em tempo 
real. O valor do Volume de Aplicação deve coincidir com o 
valor do mapa de prescrição.

• Show Track Only mostra apenas a linha central da trajetória 
do avião.

• Desired Target Rate mostra quando a aplicação está dentro 
da taxa de aplicação desejada. Desired Target Rate mostrará o 
volume de aplicação desejado  antes de entrar no bloco 
correspondente do mapa de prescrição porque ele inclui a 
compensação do tempo que leva entre abrir a válvula e o 
produto chegar ao solo.  
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• Outline Spray Blocks faz com que as bordas das faixas 
apareçam delimitadas por uma linha, criando assim retângulos 
que tem como largura a largura da faixa e como comprimento 
a distância percorrida no intervalo de gravação, quando esta 
caixa é marcada. Se esta caixa não for marcada, a faixa é 
desenhada sem limitação em blocos. 

• Display Flow Rate Colors mostrará os blocos de aplicação 
em diferentes cores, dependendo do volume de aplicação, se 
esta caixa for marcada.   Se esta caixa não for marcada, todos 
os blocos de aplicação serão mostrados em uma só cor.

• A. Display Spray On mostrará como aplicado a partir da 
abertura da válvula.

• B. Display Non-Zero Flow Rates mostrará ainda como 
aplicado, mesmo se a válvula estiver fechada, se houver ainda 
vazão  maior que zero na linha. Esta opção torna possível 
detectar válvulas com vazamento. 

• A or B - mostrará como aplicado nas duas situações 
anteriores (A ou B).

Mostrando trechos não aplicados (Display Non-Spray Trace)

Quando esta caixa é marcada, o percurso efetuado sem aplicar é 
mostrado, em adição aos trechos marcados. Quando esta caixa é 
desmarcada, somente os trechos aplicados são mostrados.

Nota: Esta função somente se aplica aos arquivos dos 
programas  AirTrac/AirStar/ForestStar/LiteStar II.  
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Mostrando marcações (Display Markers)

Quando esta caixa está marcada, as posições definidas pelo usuário 
serão mostradas. Estas podem incluir os pontos A, B e C, 
waypoints, marcas de posição, limites de áreas, etc. Marcando 
Posições de Gravação (Mark Logged Positions) 

Quando esta caixa é marcada, uma marca (em forma de triângulo) 
é desenhada em cada posição GPS de gravação. (N.T. a cada 
"intervalo de gravação", definido pelo operador). Lembre-se, como 
padrão, uma posição GPS é gravada a cada 5 segundos.  

Ajustando opções de exibição da aplicação  
(Spray Display Options)

Se o mapa de aplicação não corresponder exatamente ao atraso 
que existe entre abrir a válvula e o produto atingir o alvo, ou não 
refletir adequadamente o  "trespasse"  entre faixas consecutivas, 
você pode ajustar estes parâmetros (Nota: as discrepâncias acima 
podem ser causadas, também por ajustes inadequados dos 
parâmetros do AerialACE VRate Lead Time eEdge Lead Time) 
(N.T. quando usando o programa AirTrac). 

• Real Time Projection não é uma opção selecionável. Real-
time projection reflete o ajuste adotado no equipamento 
DGPS quando o arquivo foi gravado. Ele mostra o tempo que 
leva o sistema para atingir a locação pretendida  com a taxa de 
aplicação desejada. 

Nota: Se  Real-Time Projection estiver correto no 
sistema DGPS, Spray Compensation (abaixo) deverá ser  
“0,”
Número de Parte: 875-8086-002
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• Spray Compensation mostra um valor em segundos, usado 
para compensar a diferença entre a posição na qual a válvula é 
aberta e o início da aplicação, ou posicionamento da antena 
frente à posição da barra e, ainda, o atraso que existe entre a 
posição na qual  o produto é liberado  e aquela em que atinge 
o alvo.

• Overspray %  especifica a percentagem a aplicar no aumento 
da largura de faixa mostrada, para refletir o trespasse entre 
duas faixas consecutivas. Isto não afeta o cálculo da área 
aplicada. 

Mostrando legendas de latitude/longitude  
(Display Latitude/Longitude Marks)

Quando esta caixa é marcada, os valores de latitude e longitude 
são desenhados ao redor das margens da janela do mapa. 

Mostrando a escala do mapa na janela do mapa  
(Display Scale Bar)

Quando esta caixa é marcada, uma barra mostrando a escala do 
mapa é apresentada no canto esquerdo do mapa. 

Nota: Esta função somente se aplica aos arquivos dos 
programas  AirTrac/AirStar/ForestStar/LiteStar II.  
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Ajustando o tamanho dos rótulos das Marcas  
(Marker Font Size (mm))

Este valor define a altura das letras que compõem o rótulo 
atribuído a uma marca de localização. Aumente este valor se você 
tiver dificuldade para ler os rótulos das marcações. (por exemplo. 
pontos   A, B, C , limites de áreas, waypoints, "marks")
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Formatando a apresentação dos valores de Latitude e Longitude 
(Lat/Lon Display Format)

Esta caixa permite ao usuário escolher o formato como os valores 
de latitude e longitude serão mostrados na janela de mapas.   

Você tem três opções:

• DD.DDDDDD° - Graus e frações de Grau.

• DD°MM.MMMM’ - Graus, Minutos e frações de Minuto.

• DD°MM’SS.S” - Graus, Minutos, Segundos e décimos de 
Segundos.

Ajustando sistema de unidades (Display Units)

Selecione U.S. (pés, acres, milhas/hora, etc.) ou Metric  (metros, 
hectares, quilômetros/hora, etc.) para apresentação pelo MapStar.  
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Selecionando mapas de plano de fundo (Background Map Setup)

Selecione Background Map Setup para definir mapas a serem 
mostrados como Plano de Fundo na tela do MapStar.

Para selecionar um mapa como plano de fundo: 

1. Selecione o botão Background Map Setup na janela  Dis-
play Options.  Você verá a seguinte tela:

2. Em Maps Directory selecione o diretório onde você mantém 
seus mapas. Como padrão eles estarão em  C:\Satloc\Maps. 

3. No campo  Map Serial Number insira o número de oito dígitos, 
se você dquiriu um arquivo Satloc *.bmf, criptografado.

4. Nos campos em Map Display Control selecione as seguintes 
opções: 

• No Map Display - nenhum mapa será mostrado

Nota: Se você tiver algum problema ao ler aqueles 
arquivos, entre em contato com o Apoio Técnico da 
Satloc.
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• Selected Map (através do teclado ou Pesquisando 
Diretórios com mouse) - seleciona apenas um mapa

• Automatic Map Display - mostra todos os mapas do 
Diretório Maps, que se enquadram nas coordenadas do 
trabalho carregado.

Dica - Para adicionar ou remover um mapa na tela, selecione View > 
Map Files a partir da barra de menus principal. 

Ajustes de Impressão (Setting Printing Options)

Pressione o botão Printing Setup na janela Display Options 
para ajustar as opções de impressão. Você verá a seguinte janela:

1. Em Company Name/Title e Plot Title entre com o nome da 
empresa, Título e Título do Trabalho, respectivamente. Tais 
informações serão impressas em todos os relatórios que você 
imprimir.

2. Nos botões Auto Scale ou Fixed Scale selecione Auto Scale 
para automaticamente ajustar a escala do mapa ao tamanho do 
papel de impressão. Escolha Fixed Scale para atribuir uma 
escala para impressão (por exemplo 1:100).
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Dica! Use Print Preview para ver na tela como ficará a impressão.

Selecionando Cores para mostrar diferentes Taxas de Aplicação 
(Color Setup)

Você pode selecionar diferentes cores para diferentes Taxas de 
Aplicação da seguinte forma: 

• Default - o MapStar automaticamente atribuirá cores para 
Taxas de Aplicação pré-definidas.

• Apply Range - o MapStar seleciona cores baseado nos 
valores máximo e mínimo da taxa de aplicação encontrados 
no arquivo em uso. 

• custom - mude manualmente as cores de cada faixa de taxa 
de aplicação, "clicando" no bloco colorido e selecionando a 
nova cor na janela que se abrirá.  

Apply Range Para fazer o MapStar automaticamente selecionar cores 
de taxa de aplicação:

Pressione o botão Apply Range. O MapStar irá 
automaticamente selecionar cores para as taxas de aplicação, 

Nota: Veja o apêndice para exemplos de impressão.
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dentro da faixa mostrada nos campos Range Minimum/
Maximum nesta janela.

Figura 3-6. Limites Min/Max do mapa.
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Custom Para selecionar cores personalizadas para taxas de apli-
cação:

MapStar comportará até 12 faixas de taxa de aplicação - as 11 
que você escolhe, mais qualquer coisa acima da última faixa 
escolhida. 

Por exemplo, na figura a seguir nós selecionamos o botão 
indicado pelo número "3" porque nós só desejamos mostrar 
as seguintes quatro faixas de volume de aplicação: 

•> 2,5

•1,5 - 2,5

•0,5 - 1,5

•< 0,5

Nota: Se você desejar definir 4 faixas, você deverá 
selecionar o botão de número "3". Isto permitirá que você 
entre com os valores nas faixas de 1 ÷ 3. Note que, se 
fizermos isso, os botões acima de "3" não são selecionáveis 
- nós podemos apenas definir as faixas de 1 - 3.  Se 
tivéssemos selecionado "11" nós poderíamos definir 
valores para as faixas de  1 ÷ 11.
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Note que a cor do topo não possui valores selecionáveis - ela 
automaticamente será usada para mostrar qualquer coisa 
acima do último valor selecionado (neste exemplo, > 2,.5): 

Figura 3-7.  Valor padrão.

Você pode também mudar as cores associadas com cada 
botão. Para mudar a cor associada com a faixa de taxa de 
aplicação, "clique" duas vezes sobre o retângulo colorido.  Por 
exemplo, na figura mostrada a seguir, nós "clicamos" duas 
vezes no retângulo colorido ao lado do botão "1". A janela de 
cores abriu e nós selecionamos a cor marrom para 
representar valores de taxa de aplicação associados  ao botão 
"1" (<0.50). 
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Dica! Você não vê a cor desejada? Selecione Definir Cores 
Personalizadas >> na janela de Cores para selecionar dentro de 
toda gama de cores disponível em sua tela.

Figura 3-8.  Definição de Cor personalizada.

Nota: Você deve ter no mínimo um monitor com 
capacidade de cores a 24-bit para usar esta função.  
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Importando um arquivo

Use o ícone Import Log na Barra de Gerenciamento de Dados 
para importar um arquivo de aplicação Satloc de um cartão 
PCMCIA, Compact FLASH, ou de outro diretório do disco rígido 
de seu computador.

Para importar um arquivo gravado:

1. Pressione o icone  na Barra de Gerenciamento de 
Dados. Você verá a seguinte janela:

Nota: Recomendamos criar diretórios separados para cada 
cliente, ou para cada piloto, para evitar confusões.
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Dica! Você também pode acessar esta janela sem abrir o MapStar 
- simplesmente selecione Iniciar > Programas > Satloc > Log 
Import a partir do menu Iniciar do Windows.

2. Selecione uma opção de importação. A janela Satloc Log 
Import permite:

• copiar e/ou mover arquivos (*.log) do leitor de cartões 
(D:\drive) para o disco rígido do computador (colocando-
os no diretório Satloc\Logs como padrão).

• selecionar múltiplos arquivos "clicando" em cada um dos 
arquivos desejados ou  selecionar todos "clicando" em  
Select All Files

• cancelar seleções  se você cometeu algum erro  

• apagar arquivos selecionados

Atenção! 

Se você apagar um arquivo, ele será  permanentemente 
apagado da memória..
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Visualizando dados de um arquivo

O MapStar proporciona-lhe a flexibilidade de visualizar detalhes de 
um arquivo de serviços em formato gráfico ou relatório detalhado, 
e ainda ver mapas detalhados e informações GIS.  

Abrindo um arquivo

Para abrir um arquivo no  MapStar:

1. Selecione uma das seguintes opções:

• selecione File > New para abrir uma  nova  página a ser 
usada para mostrar dados gerados por um sistema Satloc 
- este comando não é necessário se você apenas deseja 
ver um mapa ou arquivo de cada vez.   Este comando abre 
uma nova janela.  Para alternar entre múltiplas janelas, 
abra o menu Window e escolha uma das janelas listadas.

Dica! Você agora também pode abrir múltiplos arquivos de 
uma só vez, usando os comandos File > Open ou File > 
Load Log ao invés de abri-los um a um  com o comando File 
> New . 

Para selecionar múltiplos arquivos, pressione e mantenha 
pressionada a tecla  CTRL enquanto usa o mouse para 
"clicar" nos arquivos desejados. Para selecionar um bloco de 
arquivos, "clique" no primeiro arquivo no topo do bloco. A 
seguir pressione e mantenha pressionada a tecla  SHIFT  e 
"clique" no último arquivo do bloco. 
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• selecione File > Open para abrir um arquivo existente  
em uma nova janela

• selecione File > Load Log ( ) para adicionar um arquivo na 
janela ativa

Após selecionar File > Open ou File > Load Log, você verá 
a janela  Log Open.

Você pode classificar a lista de arquivos em ordem ascendente 
ou descendente, "clicando" no botão apropriado. Para 
selecionar múltiplos arquivos a abrir, pressione e mantenha 
pressionada a tecla  CTRL enquanto "clica" nos arquivos 
desejados. 

Dica! Para selecionar um diretório diferente onde estarão os 
arquivos dsejados, pressione o botão Select Folder .
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Visualizando o mapa do serviço

Após abrir um arquivo, você verá o mapa de aplicação 
correspondente aos dados do arquivo, na janela principal: 

Figura 4-1. Exemplo de Mapa de Aplicação.

Lembre-se! Use os botões  e  para aproximar/afastar e 
deslocar o mapa. "Clicando" o botão esquerdo do mouse, com  a ferramenta de 
aproximação ativada, aproxima (aumenta) o mapa; "clicando"o botão direito, 
afasta (diminui). 

Este mapa permite-lhe:

• visualizar informações gerais, tais como vista geral da área 
aplicada, taxas de aplicação, latitude/longitude, área, volume 
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aplicado, e se ele representa uma aplicação de líquidos ou 
sólidos. 

• visualizar informações mais detalhada em um ponto particular 
do mapa - latitude / longitude, velocidade, número da faixa, 
hora, rumo, altitude, idade diferencial, etc. 

• medir distância ou área entre pontos selecionados no mapa 

• visualizar canais de aplicação individuais

• visualizar detalhes de aplicações em taxa variável - controla 
cores para exibição das taxas variáveis, percurso aplicando / 
não aplicando, gravação de dados para vazão / taxa de 
aplicação. 

Visualizando 
Informações 

Gerais do 
Mapa

Adicionalmente à visualização rápida da situação de seu padrão de 
aplicação, cobertura, taxa de aplicação e volume aplicado, você 
pode ter informações gerais olhando a parte inferior da janela do 
MapStar. 

A Barra de Informações mostra a latitude e longitude da 
posição atual do cursor, *volume de aplicação, área e *volume total 
aplicado de todos os arquivos abertos na janela ativa.   

Figura 4-2. Barra de Informações.

Nota: Estes ítens (*) são mostrados somente onde o Controle 
de Fluxo Satloc foi usado.  A precisão destes valores depende 
do uso correto dos valores de calibração do sistema.  

Latitude &Longitude Volume de Area Volume
(na posição do cursor) aplicado

Modo
 aplicação
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Diretamente acima da barra de informações, à direita, você 
visualiza o Quadro de Volumes:

Figura 4-3. Quadro de Volumes.

O quadro de volumes mostra o total de volume aplicado e se você 
estava usando produto líquido ou sólido (líquidos são mostrados 
como Litros ou Galões; sólidos são mostrados como Libras ou 
Kg). 

Visualizando 
Informações 

Detalhadas de 
Posição

Adicionalmente à visualização das informações básicas do mapa, 
você pode ver informações pontuais mais detalhadas "clicando" em 
qualquer ponto do mapa. Uma  Janela de Posição Detalhada 
aparece, mostrando: 

• arquivo do mapa de prescrição (se aplicável)

• Volume aplicado

• Área aplicada

• hora

• Latitude/Longitude

• estado da aplicação (aplicado / não aplicado)

• situação da válvula (aberta / fechada)

• informações climáticas (com opcional Avantec)

Volume de produto
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• altitude

• rumo

• velocidade

• número da faixa

• Larg. faixa

• distância de desvio

• ângulo de visada dos satélites

• DOP

• idade diferencial

• informações de fluxo - Vazão (volume/minuto) e *taxa de 
aplicação (volume / área)

• Taxa de aplicação desejada

• atraso de compensação (segundos)

• valor de calibração da turbina

• limite da área

Os botões semelhantes ao de um gravador de vídeo na Janela de 
Informações Detalhadas são usados para mover o "veículo"  

Nota: Pressionando o botão App/Area na  Janela de 
Informações Detalhadas você verá separadamente a 
taxa de aplicação em cada canal. 
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através do arquivo. A Janela de Informações Detalhadas pode 
ser arrastada para outras áreas da tela, se desejado.

Figura 4-4. Janela de Informações Detalhadas.

Dica! Para mudar o sistema de unidades, selecione  e mude o 
"Display Units" conteúdo.
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Figura 4-5. Taxa de aplicação por canal.

Figura 4-6. Informações climáticas.
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Medindo 
Distâncias ou 

Áreas 

Você pode medir distância ou área entre pontos selecionados no 
mapa. 

Para medir a distância entre dois pontos do mapa: 

2. Selecione o ícone na Barra Principal.

3. Defina o ponto de início pressionando o botão esquerdo com 
o cursor sobre ele. 

4. Libere a pressão sobre o botão esquerdo e desloque o cursor 
até o ponto de destino, pressionando o botão esquerdo sobre 
ele. A distância será mostrada na Barra de Informações na 
parte inferior da tela. 

Para medir a área de um  polígono no mapa: 

1. Selecione o ícone na Barra Principal.

2. Defina o polígono "clicando" com o botão esquerdo sobre os 
vértices do polígono desejado - após o terceiro vértice, a área 
medida passa a ser mostrada na Barra de Informações. 

3. Para abandonar o polígono e começar de novo, pressione o 
botão direito do mouse.
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Visualizando 
Canais de 
Aplicação 

Individuais

Quando múltiplos produtos tiverem sido aplicados, você poderá 
visualizar cada produto como um canal individual de aplicação. 

Para visualizar canais de aplicação individuais:

1. Selecione o ícone na Barra Principal. Você verá a seguinte 
janela:

2. Selecione o(s) botão (ões) próximos aos canais de aplicação 
que você deseja mostrar.

Visualizando 
Detalhes de 

Aplicação em 
Taxa Variável

MapStar proporciona recursos para aplicação em taxas variáveis.  
O mapa irá atribuir diferentes cores para diferentes taxas de 
aplicação, dependendo de como você configure o MapStar (veja 
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"Capítulo 3:  Iniciando"  para mais informações sobre como 
atribuir cores às diferentes taxa de aplicação.)

Figura 4-7. Exemplo de Mapa: Variações de cor representam
Variações de Taxa de Aplicação.

Você também pode configurar para mostrar quando a aplicação 
está sendo efetuada, ou quando a válvula está fechada mas você 
não está obtendo vazão zero (indicando um potencial vazamento 
na válvula).

Cores diferentes
indicam mudança de taxa de aplicação
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Imprimindo um relatório das informações gravadas

Para imprimir um relatório dos dados  gravados:

1. Selecione  View > Log Files. Será mostrada uma lista dos 
arquivos atualmente carregados. Você pode remover um 
arquivo da lista "clicando" com o botão esquerdo no nome do 
arquivo para realçá-lo e então pressionando o botão 
Remove.
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2. Pressione o botão Show Log Info para mostrar detalhes de 
um arquivo selecionado.

3. Pressione o botão Print Report para imprimir as 
informações.

Nota: Os formatos de apresentação e impressão podem 
variar dependendo do conteúdo dos arquivos  LOG, VRC, 
ou SWA e da versão dos programas que os criaram. 
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Imprimindo um relatório de fluxo

Para imprimir um  relatório de fluxo:

1. Selecione o ícone na Barra de Gerenciamento de 
Dados para imprimir um Relatório de Fluxo. Você verá a 
seguinte tela::

2. Selecione Browse para selecionar o arquivo desejado.

3. Selecione View, Print, ou Save para respectivamente 
visualizar, imprimir, ou gravar o relatório gerado.

Dica! "Clique" em  Options para mudar de sistema de unidades e 
para adicionar novas colunas (Tempo na Faixa, Tempo no "balão", 
Latitude, Longitude e Altitude no início da faixa).  
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Exportando um arquivo

Use o ícone  Export Log na Barra de Gerenciamento de Dados 
para exportar um arquivo gravado em formato Satloc  (LOG, 
SWA, ou VRC) a partir do disco rígido de seu computador.

Figura 4-8. Janela de Exportação de Arquivos.

Gravações de informações de aplicação e de trajetória de vôo 
podem ser exportadas  para os seguintes tipos de arquivos: 

• Texto ASCII

• DXF

• MID/MIF
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• SHP - três tipos de arquivos SHP podem ser gerados  
diferindo em tamanho de polígono e dados incluídos.

Dica! Você pode também acessar esta janela sem abrir o MapStar - 
simplesmente selecione  Iniciar > Programas > Satloc > Log 
Export a partir do menu Iniciar do Windows.

Dica! Agora você pode exportar múltiplos arquivos ao mesmo tempo. 
Pressione e mantenha pressionada a tecla CTRL enquanto "clica" nos 
arquivos desejados. Então pressione Open para exportar todos os 
arquivos selecionados ao mesmo tempo.

Figura 4-9. Exportando múltiplos arquivos.
Número de Parte: 875-8086-002



Página 58  |  Manual do Usuário MapStar 
Exportando para  ASCII

Arquivos ASCII podem ser usados para importar dados em uma 
planilha ou programa gráfico. Este formato é comumente usado  
para armazenar ou examinar dados. O formato ASCII pode ser 
tanto limitado por Tab  (tabulação) como por Comma (vírgula) 
ou em uma lista - Listing que mostra apenas as ocorrências mais 
relevantes gravadas. 

Para exportar para  ASCII:

1. Selecione o ícone   na Barra de Gerenciamento de 
Dados.  Será aberta a janela Satloc Log Export .

2. Escolha o formato do arquivo de saída (selecionando as 
informações que deverão estar nele contidas, e em qual 
ordem), para tanto pressionando o botão ASCII Format. 
Você verá a seguinte tela:
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3. Selecione os ítens que você deseja visualizar no relatório, 
destacando-os com o cursor e usando os botões  (>, >>, <<, 
<) para mover os campos escolhidos para a direita ou de volta 
à esquerda; a ordem de apresentação pode ser mudada 
através dos botões Move Up/Down. Um cabeçalho do 
relatório  ASCII também pode ser impresso no início do 
relatório, se marcada esta opção.    

Somente os campos de dados que são disponíveis no tipo de 
arquivo que você está convertendo são mostrados como 
opção para exportação em  ASCII. 

Dica! Você poderá ver todos os tipos de dados marcando a caixa 
ao lado de Show all fields. Mas fique ciente de que as 
informações que não são disponíveis no tipo original do arquivo não 
poderão ser exportadas para o arquivo  ASCII. 

4. Pressione OK quando completada sua seleção de opções. O 
formato de  opções será armazenado como padrão para 
futuros usos.  

5. Pressione  Select Log para escolher o arquivo que você 
deseja converter.  

6. Pressione  Write File para dar nome ao futuro arquivo ASC 
. O programa iniciará a exportação e a barra de  Progresso 
mostrará o andamento.   
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Exportando para  DXF

Para exportar para  DXF:

1. Selecione o ícone   na Barra de Gerenciamento de 
Dados. Será aberta a janela Satloc Log Export.

2. Pressione DXF e DXF Options para abrir a seguinte janela 
de diálogo: 

3. "Clique" em  Spray-on segments only se você deseja que o 
seu arquivo DXF seja constituído apenas pelos trechos 
aplicados de seu mapa. Não selecione esta caixa para exportar 
todos os trajetos percorridos (Aplicados e Não-aplicados). 

4. Pressione OK.

Nota: Você pode, nesta versão, exportar os trechos não 
aplicados, adicionalmente aos aplicados. As informações serão 
combinadas em um único arquivo exportado. 
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Exportando para  MID/MIF

Para exportar para  MID/MIF:

1. Pressione MID/MIF Options para abrir a seguinte janela de 
diálogo: 

2. Selecione Individual Polygons for each spray position 
para criar um polígono separado para cada posição de 
gravação (usualmente uma por segundo); ou selecione   
Combine spray positions into larger polygons para 
verificar a existência de polígonos vizinhos - se possível, o 
MapStar irá juntá-los em um polígono maior. Isto cria um 
arquivo menor. 

3. Nos botões MID File Format, selecione o tipo de delimitador a 
usar para separar campos no arquivo MID/MIF (Comma, 
Tab, ou Space Delimited). 
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4. No campo Number of spray channels, selecione o número de 
canais a converter para MID/MIF.

Exportando para  SHP

Há três opções de arquivos. Shape para exportar:

• ESRI Shape (SHP) - este é o formato ESRI básico

• Detailed Shape (SHP) - contém as informações de controle de 
fluxo.

• Spray Shape (SHP) - contém todas as informações 
relacionadas ao comando de aplicação 

ESRI Shape Para exportar para  ESRI SHP:

1. Pressione o botão SHP Options para configurar sua prefer-
ência quanto ao polígono SHP.  Você verá a seguinte janela:

2. Selecione Individual Polygons for each spray position 
para criar um polígono separado para cada posição de 
gravação (usualmente uma por segundo); ou selecione 

Nota: Você pode, nesta versão, exportar os trechos não 
aplicados, adicionalmente aos aplicados. As informações serão 
combinadas em um único arquivo exportado. 
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Combine spray positions into larger polygons para 
verificar a existência de polígonos vizinhos - se possível, o 
MapStar irá juntá-los em um polígono maior. Isto cria um 
arquivo menor. 

Detailed Shape 
(SHP)

Esta opção exportará o arquivo SHP com informações completas 
de controle de fluxo.  Não há opções de formato para esta 
seleção. 

Spray Shape 
(SHP)

Esta opção exportará o arquivo SHP com informações sobre o 
comando de aplicação (válvula aberta / fechada). Não há opções de 
formato para esta seleção. 

Nota: Você pode, nesta versão, exportar os trechos não 
aplicados, adicionalmente aos aplicados. As informações serão 
combinadas em dois arquivos separados.
Número de Parte: 875-8086-002





TRABALHANDO COM 
ARQUIVOS GIS

Importando arquivos GIS

Editando arquivos GIS

Criando arquivos Satloc JOB

Capítulo

5



Página 66  |  Manual do Usuário MapStar 
Importando arquivos GIS

O MapStar comporta diversos formatos de arquivos GIS, incluindo 
DXF, SHP e MID/MIF, os quais podem ser exportados como 
arquivos JOB Satloc.  

Os arquivos DXF, SHP e MapInfo MIF são arquivos de polígonos no 
sistema de coordendas WGS-84, sobre os quais as informações de 
aplicação podem ser mostradas.  Eles podem ser exportados no 
formato JOB para uso nos sistemas FreeTrac / AirTrac e ForestStar 
como mapas de fundo, e no AirStar e ForestStar como polígonos. 
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Para carregar um arquivo JOB, PMH, DXF, MIF, or SHP:

1. Selecione o ícone  para  Adicionar, Remover, criar 
um Novo Arquivo, Editar, Salvar Como ou Zoom All 
Serviços e arquivos GIS ao mapa atualmente mostrado na tela.  

2. Selecione a opção de visualização apropriada para seus arqui-
vos GIS. Para melhor apresentação e tamanho de arquivo, 
selecione  “Compatible with AirTrac” ou “Compatible with 
AirStar.”

• Vertex Reduction permite-lhe reduzir manualmente o 
número de vértices de  polígonos quando gravando o 
arquivo *.job. Digite  a distância entre pontos, na caixa 
logo abaixo deste botão, que o MapStar usará para 
descartar vértices de polígonos desnecessários.  

• Compatible with AirStar automaticamente reduz os 
vértices dos polígonos. 

• Compatible with AirTrac automaticamente reduz os 
vértices dos polígonos. 
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• All Points gravará TODOS os vértices dos polígonos - 
isso resultará em um arquivo muito grande, entretanto.  

3. Selecione Add para buscar o arquivo desejado e abrí-lo. Uma 
vez aberto, o arquivo é adicionado como uma camada abaixo 
do mapa atualmente mostrado. 

O mapa automaticamente se ajustará para incluir todos os 
arquivos  JOB ou GIS que tenham sido adicionados.   

Nota: "Clique" em Display Attributes para ver os 
atributos de arquivos  SHP e MIF.
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Editando arquivos GIS

Você pode editar arquivos JOB ou GIS e então exportá-los como 
arquivos JOB Satloc para uso em equipamentos Satloc. 

Para editar um arquivo GIS: 

1. Selecione o ícone  .

2. Na janela Job and GIS Files Window, selecione Edit. Você 
verá a seguinte janela:

3. Coloque o cursor sobre o objeto que você deseja editar, na 
tela principal,  e "clique" com o botão esquerdo.   Para 
polígonos, "clique" sobre uma das bordas. Para *Padrões, 
"clique" na linha  A-B. Para "Marks", "clique" diretamente 
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neles. O objeto selecionado ficará realçado. Você também 
pode selecionar um objeto escolhendo-o na caixa  Select 
Object.

Uma extensão da caixa de diálogo aparecerá com as várias 
opções de alteração que podem ser efetuadas com o objeto 
selecionado. 

*Nota: Atualmente, apenas as 10 primeiras faixas são mostradas 
em um "padrão". 
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Criando arquivos Satloc JOB

Um arquivo Satloc JOB é usado no AirTrac, AirStar e SwathStar 
M3 - ele permite que você use/modifique arquivos GIS existentes, 
para definir sua área de aplicação e polígonos individuais no 
MapStar. Então você pode "chamar" o arquivo *.JOB em seu 
equipamento Satloc, tal como o AirStar e começar a receber 
orientação de acordo com este arquivo.

Gravando um arquivo GIS como um arquivo Satloc JOB

Você pode gravar qualquer arquivo GIS como um arquivo JOB 
para uso com os sistemas AirTrac, AirStar, ForestStar, ou 
FreeTrac. 

Gravando um arquivo GIS como um arquivo Satloc JOB:

1. Selecione o ícone  .

2. Na janela Job and GIS Files Window, selecione Edit.

3. Grave o arquivo com a extensão JOB (*.job). Se o arquivo Job 
contém mais de 99 polígonos, ou 999 vértices por polígono 
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(98901 vértices são permitidos em um arquivo Job), você verá 
a seguinte mensagem: 

Criando um novo  arquivo JOB

Você tem a opção de criar um novo arquivo JOB. 

Para criar um novo arquivo JOB:

1. Selecione o ícone  .

Nota: O nome de um arquivo JOB deve ser um número de 
1 a 999. Por exemplo, 36.job é um nome válido para um 
arquivo JOB. 

Atenção! 

AirStar, AS2000, ForestStar e FreeTrac usam este 
arquivo JOB somente se estiver nomeado entre 1 e 500.

AirTrac usa arquivos JOB apenas se nomeados entre 1 e 
999.
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2. Na janela Job and GIS Files Window, selecione New Job. 

3. Pressione  New para criar seu primeiro Polígono, Linha de 
Polígono, Padrão ou Marca.  

4. Nos botões  Job File Objects  escolha o tipo de objeto e 
"clique"  em  OK.

• Para criar um polígono: 
Clique para inserir novos pontos (vértices) que irão 
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formar as bordas do polígono. Mova ou apague pontos se 
necessário:

• Para criar uma  linha de polígono: 
Clique para inserir novos pontos (vértices), que formarão a 
linha de polígono (N.T. Polígono Aberto).   Pontos podem ser 
adicionados ou removidos, como necessário. Clique com Botão 
Direito  para finalizar a linha de polígono.
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• Para criar uma marca: 
Clique para inserir uma nova Marca ("Mark"). Na caixa de 
diálogo, você pode definir o tipo de marca e atribuir-lhe um 
rótulo.  

• Para criar um padrão:

Clique sobre a posição desejada para inserir um ponto A e depois 
clique em outra posição para inserir o ponto B.   Mude outros 
valores na caixa de diálogo, como necessário. 

Nota: Uma marca ("mark") é simplesmente um ponto que 
aparece na Janela de Mapa - ela não é um waypoint para 
navegação. 
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5. Clique em OK para finalizar. 

6. Na janela Job and GIS Files Window, selecione Save As.

7.  Grave o arquivo com a extensão JOB (*.job). 

Nota: O nome de um arquivo JOB deve ser um número de 
1 a 999. Por exemplo, 36.job é um nome válido para um 
arquivo JOB. 

Atenção! 

AirStar, AS2000, ForestStar e FreeTrac usam este 
arquivo JOB somente se estiver nomeado entre 1 e 500.

AirTrac usa arquivos JOB apenas se nomeados entre 1 e 
999.
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Sobre Rotas & Waypoints

Agora você pode facilmente pré-programar Waypoints (N.T. 
Pontos de Referência) no MapStar para uso com qualquer sistema 
Satloc.

Um Waypoint é definido pelas coordenadas GPS   (latitude e 
longitude) de uma posição significativa. Por exemplo, você pode 
querer plotar um waypoint ao longo de uma rota, como uma 
marcação onde parar ou mudar de rumo.

O MapStar  permite  numerar e nomear cada waypoint que você 
cria e associá-lo a uma rota em particular. 

Uma Rota é constituída por um conjunto de waypoints. Você não 
pode criar um waypoint sem criar uma rota - ainda que só 
configurando um único waypoint.

Nota: Se configurando um único waypoint, use a Rota 1. Se 
definindo múltiplas rotas, associe cada waypoint com a rota 
desejada.

Nota: O MapStar permite-lhe criar um máximo de 99 rotas e 
99 waypoints em cada rota.
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Programando Rotas & Waypoints 

Para programar um  Waypoint e associá-lo a uma Rota: 

1. Selecione o ícone  na Barra de Gerenciamento de   
Dados. Você verá a seguinte tela:

• Selecione Create a new file para criar um novo arquivo 
de waypoints. Para adicionar um  waypoint, você pode 
tanto clicar na localização desejada no mapa (o que 
preencherá automaticamente os campos de latitude e 
longitude), ou introduzir manualmente as coordenadas.  
Depois de preencher as coordenadas, atribua um número 
de rota, um número de waypoint, e um nome.
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• Selecione Open an existing file para editar um arquivo 
de waypoints já existente. Localize o arquivo e abra-o. 
Para editar um waypoint, clique duas vezes sobre ele.

2. Grave o arquivo com a extensão .DAT.
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Sobre Mapas de Prescrição

O programa MapStar pode converter uma imagem de satélite em 
infravermelho, ou outro arquivo Shape (SHP) de uma lavoura, em 
um mapa de prescrição.   

Um arquivo SHP converte uma foto geográfica em um vetor de 
coordenadas. Um arquivo SHP permite que um programa de 
computador facilmente leia aquelas coordenadas e redesenhe as 
linhas e áreas que fazem a representação bi-dimensional geográfica, 
como a de uma lavoura.  Áreas são representadas em um arquivo 
SHP como polígonos fechados - são estas áreas que permitem-lhe 
informar  ao programa de taxa de aplicação variável onde iniciar / 
mudar / interromper a aplicação. 

O MapStar primeiramente converte o arquivo SHP em um mapa 
de prescrição. O MapStar então lê um dos temas no arquivo SHP 
para atribuir uma taxa de aplicação específica para as diferentes 
áreas do mapa, como necessário.  
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Importando arquivos GIS com Vrate

O menu Vrate permite importar arquivos e taxas de aplicação 
associadas e criar um mapa de prescrição (PMH/PMD ) para uso 
no campo. 

Nota: Seu monitor deve comportar cores a 24-bit ou mais para 
que Vrate possa mostrar as cores corretamente. Se sua 
configuração tiver menos que 24-bit, você verá a seguinte janela 
com mensagem de erro:  

Para mudar sua configuração de cores, clique com o botão 
direito sobre a tela do Windows. Selecione Properties para 
possibilitar ver e mudar os ajustes do monitor. Assegure-se de 
que o ajuste de Color quality esteja em 24-bit ou mais.
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Para importar um arquivo SHP: 

1. Selecione Vrate > SHP (SHAPE).

2. Selecione o arquivo SHP que você deseja importar. 

3. Uma vez que você tenha selecionado um arquivo SHP, você 
verá a seguinte janela, apresentando os canais DBF apropriados: 

Nota: Se a caixa Display Numerical Values estiver marcada, 
você também verá os valores numéricos mostrados no arquivo 
gráfico na tela. 

Nota: arquivos DBF podem ser constituídos por vários canais 
de dados. Somente canais numéricos válidos são selecionáveis. 
Em nosso exemplo, Rate_Cal é o canal desejado no arquivo 
DBF.
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4. Clique OK, e você verá a seguinte janela: 

5. Em Field Name e Chemical Name, digite respectivamente o 
nome da lavoura  e nome do produto se você desejar que 
apareçam em seu mapa. 

Nota: Se o arquivo contiver mais de 99 polígonos ou 999 
vértices em um polígono, você verá a seguinte mensagem: 

Clique OK para continuar.
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6. Selecione All Polygons (todos os polígonos) ou Outside 
Polygons Only. (apenas polígonos externos). Selecionando Out-
side Polygons Only permite que o MapStar mostre apenas a 
borda externa do grupo de polígonos. Isto permite ao MapStar 
redesenhar rapidamente o mapa durante atualizações da tela a 
partir das informações do arquivo PMH (N.T. arquivo de pre-
scrição). 

7. Selecione Yes para gerar um mapa VRC. Você verá um mapa  
de prescrição na tela do MapStar (mostrado na página seguinte).  
O MapStar também gerará os arquivos PMD e PMH no mesmo 
diretório do arquivo SHP. Estes arquivos são usados nas aplicações 
em tempo real com equipamentos Satloc.

Nota: VRC e  AirTrac limitam o número de polígonos a 99.  
Por representarem aplicações em tempo real, um número 
maior de polígonos causará um redesenho muito lento na 
tela.  Nós recomendamos selecionar Outside Polygons Only 
sempre que houver mais de 20 polígonos.  Note que, 
escolhendo esta opção, afetará apenas a  apresentação no 
sistema DGPS; toda informação de prescrição é ainda 
usada  ÷ apenas não será mostrada graficamente no sistema 
DGPS. 

Nota: Note que a a Sensibilidade de Resolução (Resolution 
Sensitivity) é automaticamente ajustada em “Default.”  A 
sensibilidade de resolução determina as dimensões da 
grade do polígono apresentado no arquivo PMD. Isto não 
pode ser mudado manualmente. O MapStar 
automaticamente determina a melhor sensibilidade de 
resolução para o tipo de arquivo em uso. 
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Note que que a Barra de Informações, quando trabalhando com 
arquivos SHP, não mostra o volume de aplicação no ponto do 
mapa de prescrição sobre o qual se encontra o cursor - mostra 
apenas suas coordenadas. Adicionalmente, a Barra de Informações 
mostra o total da área e total de volume aplicado (se o controle de 
fluxo tiver sido habilitado). 

No arquivo SHP , apenas 
a posição é mostrada 
no ponto no qual  o cursor 
está
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Visualizando Mapas de Prescrição

O menu Prescription Map Viewer permite visualizar mapas de 
prescrição criados pela função  Vrate para conferir as informações. 
Colocando o cursor em qualquer ponto do mapa de prescrição, 
serão exibidas, na Barra de Informações,  as coordenadas e a taxa 
de aplicação naquele ponto.  

 
Para ver um mapa de prescrição:

1. Selecione Vrate > Prescription Map Viewer.

2. Selecione o arquivo de prescrição que você deseja importar. 
Você então verá o arquivo de prescrição selecionado. 
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Visão geral

Esta seção fornece alguns exemplos de vários tipos de arquivos 
que você pode encontrar no MapStar:

• LOG

• SWA

• VRC

• SHP

• Área de aplicação com Mapa em Plano de Fundo

• Exemplos de Relatórios impressos - Arquivo de Serviço e 
Mapa de Prescrição  
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Exemplos de arquivos

LOG 

Arquivos LOG são gerados pelos programas DOS: AirTrac, 
AirStar, ForestStar, SwathStar, AS-2000, Litestar II e Lite. Um 
aspecto típico é o seguinte:

Figura A-1. Exemplo de arquivo LOG.
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SWA

Arquivos SWA são gerados pelos programas FreeTrac e AirTrac 
Windows. Um aspecto típico é o seguinte:

Figura A-2. Exemplo de arquivo SWA.
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VRC

O programa VRC / Windows pode ajustar um controlador de taxa 
variável e gravar até 10 canais de aplicação em tempo real.   Este é 
um exemplo de um mapa após aplicado.

Figura A-3. Exemplo de arquivo  VRC.
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SHP

Este é um exemplo de um arquivo Shape (SHP). O arquivo é 
constituído por uma série de polígonos, um para cada município 
dos Estados Unidos.  Arquivos SHP podem ser usados como 
mapas de fundo no MapStar ou gravados como arquivos JOB e 
usados nos equipamentos Satloc.  Os arquivos SHP podem ser 
editados dentro do MapStar, se desejado.  Contate a Satloc sobre 
fontes de arquivos SHP.

Figura A-4. Exemplo de arquivo  SHP.
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Área de aplicação com Mapa em Plano de Fundo

Figura A-5. Área de aplicação com Mapa em Plano de Fundo.
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Exemplos de relatórios impressos 

Você pode imprimir arquivos MapStar tanto no formato "Retrato"  
(Portrait) como "Paisagem" (Landscape) de acordo com suas 
necessidades. Os exemplos abaixo mostram um arquivo LOG e 
um Mapa de Prescrição impressos em modo "Retrato." As 
informações mostradas no cabeçalho da página impressa depende 
do tipo de arquivo e das informações digitadas na janela "Print 
Setup". 

Exemplo de 
arquivo  LOG

Note que o relatório impresso do arquivo LOG mostra o total da 
área e o total de volume aplicado se o controlador de fluxo tiver 
sido usado. 

Figura A-6. Exemplo de impressão de um arquivo LOG. 
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Exemplo de 
Mapa de 

Prescrição

Note que o Mapa de Prescrição mostra o total de produto 
necessário. 

Figura A-7. Exemplo de Mapa de Prescrição impresso.
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Número
Indice

A
ampliando o mapa 17

área 18, 50

área aplicada 95

arquivos

abrindo 16, 42

criação, JOB 71

edição 69

exportação 56

exportando 21

gravando 16

importação 40, 83

visualização 42

ASCII 3, 56, 58

B
Barra de Gerenciamento de Dados 14, 
20

Barra de Informações 14, 21, 45

Barra de Menus 14, 15

Barra Principal 14, 15

barras

Barra de Gerenciamento de Dados. 
Veja Barra de Gerenciam-
dento de Dados.

Barra de Informações

. Veja Barra de Informações.
Barra Principal. Veja Barra Principal.

BMF 3, 5

C
CAD DXF. Veja DXF.

canais 18

Canais de aplicação 51

Cópia de Arquivos 22

D
dados de aplicação 56

DAT 80

DBF 84

distância 18, 50

DXF 3, 6, 56, 60, 67

E
ESRI SHP. Veja SHP.

G
GIS 2, 19, 66
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I
Ícone de Cópia de Arquivos 22

Ícone de Execução Rápida do MapStar 
22

ícones da tela 22

impressão

arquivos de serviço 53

configuração 32

exemplos de impressão 96

Relatório de Fluxo 55

imprimindo

prévia da impressão 17

imprimindo arquivos 17

informações de trajeto percorrido 56

Instalação 9

J
Janela de Posição Gravada 46

JOB 3, 6, 67

L
linha de poligono 74

LOG 3, 5, 91

Logs. Veja arquivos.

M
mapa de fundo 95

mapas de prescrição 83, 88

MapInfo MID/MIF. Veja MID/MIF.

MapStar 22

MapStar, demonstração 9

marcação 74

MID/MIF 3, 6, 56, 61, 67

movendo o mapa 17

P
padrão de aplicação 75

PMD 83

PMH 3, 6, 67, 83

polígono 18, 50, 73

polígonos 86

Q
Quadro de Volumes 46

R
Relatório de Fluxo 21, 55

Relatório de informações do arquivo 53

requisitos do sistema 8

rota 78

S
SHP 3, 6, 57, 62, 67, 82, 94

SMS 3, 16

SWA 3, 5, 92
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Número
T
Taxa de AplicaçãoVariável 51

tela

Configurações de Mapa de Fundo 
31

Formato de Lat/Lon 30

Mostra Barra de Escala 28

mostra legendas de Latitude / Lon-
gitude 28

Mostra Marcações 27

Mostra trechos não-aplicados 26

Mostra Unidades 30

opções 19, 23

Tamanho das letras dos rótulos de 
marcações 29

Visualização em Modo de Aproxi-
mação 25

telas

janela principal do MapStar 14

toolbars

Barra de Menus. Veja Barra de 
Menus.

U
unidades 30, 48

V
Vrate 83

VRC 3, 5, 18, 86, 93

W
waypoints 21, 78
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